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BCA Sem V (COMPUTER GRAPHICS) 

(Unit-4) Introduction to 2D Animation Package and Scripting Language 

 

 

UNIT 4 – Introduction to 2D Animation Package and Scripting Language 

 

− Timeline Window, Layers, Key Frame, Frames 

− Toolbox 

− Types of Symbols 

− Types of Animation – Frame By Frame and Tween (Motion and Shape) 

− Onion Skinning 

− Import and Export images 

− Publish settings, Guided Layer, Alpha Effect, Using Color properties (Brightness , Tint), Masking 

(Using Filled shape, Text), Motion guide and Movie Clip Mask 

− Introduction to Action scripting 

− Play & Stop, GetURL 

 

 

Flash Overview: 
 

Flash is a multitasking application that acts like an illustration program, an image, a sound editor, 

an animation machine, and a scripting engine, all rolled into one. 

Macromedia Flash MX movies are graphics, text, animation, and applications for Web sites. It 

helps to create two-dimensional animation or graphics. They consist primarily of vector graphics, 

but they can also contain imported video, bitmap graphics, and sounds. Flash movies can 

incorporate interactivity to permit input from viewers, and you can create nonlinear movies that 

can interact with other Web applications. Web designers use Flash to create navigation controls, 

animated logos, long-form animations with synchronized sound and even complete, sensory-rich 

Web sites. Flash movies use compact vector graphics, so they download rapidly and scale to the 

viewer's screen size.  

Timeline 

The Timeline organizes and controls a document's content over time in layers and frames. Like 

films, Flash documents divide lengths of time into frames. Layers are like multiple film strips 

stacked on top of one another, each containing a different image that appears on the Stage. The 

major components of the Timeline are layers, frames, and the playhead. 

Layers in a document are listed in a column on the left side of the Timeline. Frames contained 

in each layer appear in a row to the right of the layer name. The Timeline header at the top of 

the Timeline indicates frame numbers. The playhead indicates the current frame displayed on 

the Stage. As a Flash document plays, the playhead moves from left to right through the 

Timeline. 
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The Timeline status display at the bottom of the Timeline indicates the selected frame number, 

the current frame rate, and the elapsed time to the current frame. 

NOTE  

When an animation is played, the actual frame rate is displayed; this may differ from the 

document's frame rate setting if the computer can't calculate and display the animation 

quickly enough. 

 

You can change the way frames appear in the Timeline, as well as display thumbnails of frame 

content in the Timeline. The Timeline shows where animation occurs in a document, including 

frame-by-frame animation, tweened animation, and motion paths. For more information on 

animation, see Creating Motion in Using Flash.  

Controls in the layers section of the Timeline let you hide, show, lock, or unlock layers, as well 

as display layer contents as outlines. For more information, see Editing layers and layer folders. 

You can insert, delete, select, and move frames in the Timeline. You can also drag frames to a 

new location on the same layer or to a different layer. For more information, see Working with 

frames in the Timeline. 

Layers 

Layers are like transparent sheets of acetate stacked on top of each other on the Stage. Layers 

help you organize the artwork in your document. You can draw and edit objects on one layer 

without affecting objects on another layer. Where there is nothing on a layer, you can see 

through it to the layers below.  

To draw, paint, or otherwise modify a layer or folder, you select the layer in the Timeline to 

make it active. A pencil icon next to a layer or folder name in the Timeline indicates that the 

layer or folder is active. Only one layer can be active at a time (although more than one layer can 

be selected at a time).  
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When you create a new Flash document, it contains only one layer. You can add more layers to 

organize the artwork, animation, and other elements in your document. The number of layers you 

can create is limited only by your computer's memory, and layers do not increase the file size of 

your published SWF file. Only the objects you place into layers add to the file size. You can also 

hide, lock, or rearrange layers. 

You can also organize and manage layers by creating layer folders and placing layers in them. 

You can expand or collapse layer folders in the Timeline without affecting what you see on the 

Stage. It's a good idea to use separate layers or folders for sound files, ActionScript, frame labels, 

and frame comments. This helps you find these items quickly when you need to edit them. 

In addition, you can use special guide layers to make drawing and editing easier, and mask layers 

to help you create sophisticated effects. 

Creating layers and layer folders  

When you create a new layer or folder, it appears above the selected layer. The newly added 

layer becomes the active layer.  

To create a layer, do one of the following: 

 Click the Insert Layer button at the bottom of the Timeline.  

 Select Insert > Timeline > Layer.  

 Right-click (Windows) or Control-click (Macintosh) a layer name in the Timeline and 

select Insert Layer from the context menu. 

Layers are used to keep the objects separated and control their properties. 

The Modify  Layer command opens the layer properties dialog box which is used to control 

and edit the properties of the active layer. 

The layer properties dialog box is used to facilitate various layer operations. 

 

 Name  Use this option to change the name of the layer. 

 Show  With this option checked, the layer is visible. Otherwise it’s hidden. 

 Lock  This option enables you to lock or unlock a layer. 

 Type  This option is used to set the type of layer. Three basic types exist.  

1.) Normal Layer: This is the default layer, used for drawing and animation. 

2.) Guide Layer: This can be used either as motion guides or as drawing guides. 

3.) Masked Layer: It is used to create special effects or highlight objects. 

 Outlines Color  Use this to choose the color of the layer’s outlines, which will be 

visible if View layer as outline is checked. 

 Layer height  Use this to increase the height of the layer.  

 

Frames and Keyframes 

A keyframe is a frame in which you define a change to an object's properties for an animation or 

include ActionScript code to control some aspect of your document. Flash can tween, or 

automatically fill in, the frames between keyframes you define in order to produce fluid 

animations. Because keyframes let you produce animation without drawing each individual 

frame, they make creating animation easier. You can easily change the length of a tweened 

animation by dragging a keyframe in the Timeline. 
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The order in which frames and keyframes appear in the Timeline determines the order in which 

they are displayed in a Flash application. You can arrange keyframes in the Timeline to edit the 

sequence of events in an animation. 

Working with frames in the Timeline  

In the Timeline, you work with frames and keyframes, placing them in the order you want the 

objects in the frames to appear. You can change the length of a tweened animation by dragging a 

keyframe in the Timeline. 

You can perform the following modifications on frames or keyframes: 

 Insert, select, delete, and move frames or keyframes  

 Drag frames and keyframes to a new location on the same layer or on a different layer  

 Copy and paste frames and keyframes  

 Convert keyframes to frames  

 Drag an item from the Library panel onto the Stage to add the item to the current 

keyframe  

The Timeline provides a view of tweened frames in an animation. For information on editing 

tweened frames, see Creating Motion in Using Flash. 

Flash offers two different methods for selecting frames in the Timeline. In frame-based selection 

(the default) you select individual frames in the Timeline. In span-based selection, the entire 

frame sequence, from one keyframe to the next, is selected when you click any frame in the 

sequence. You can specify span-based selection in Flash preferences. 

file:///C:\Documents%20and%20Settings\All%20Users\Application%20Data\Macromedia\Flash%208\en\Configuration\HelpPanel\Help\UsingFlash\00000608.html%23154971
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Flash drawing and painting tools: 

Flash provides various tools for drawing freeform or precise lines, shapes, and paths, and for 

painting filled objects.                                                          

 

 

1.) Arrow Tool 

It is used to reshape a line by pulling on the line itself or on its end points or corners. It is 

also used to select, move or reshape Flash elements, including lines, shapes, groups, 

buttons, objects and other items. 

 

2.) Sub selection Tool 

You can adjust straight segments to change the angle or length of the segment or adjust 

curved segments to change the slope of direction of the curve. 

 

3.) Line Tool 

It is used to create perfect straight line that extends from the starting point to end point. 
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4.) Lasso Tool 

This tool is used to group-select odd or irregular shaped areas of your drawing. After the 

areas are selected, they can be moved, scaled, rotated, or reshaped as a single unit. It can 

also be used to split shapes or select portions of a line or shape. 

 

5.) Pen Tool 

This tool is used to draw precise paths as straight lines or smooth, flowing curves. You 

can create straight or curved line segments and adjust the angle and length of straight-line 

segments and the slope of the curved segments. 

 

6.) Text Tool 

This tool is used to create and edit text. Text tool provides three kinds of Text boxes. 

 

7.) Oval Tool 

The Oval Tool is used to create perfectly smooth oval. Ovals are drawn by dragging from 

one edge of the shape being drawn to the other. 

 

8.) Rectangle Tool 

This tool creates a perfect rectangle. They are drawn by dragging from one edge to the 

other. 

 

9.) Pencil Tool 

You can draw lines and shapes with the pencil tool, much like drawing with a real pencil. 

After you draw lines, Flash straighten or smoothen them. The amount of straightening or 

smoothening depends on the selected drawing mode. Flash also segments lines at sharp 

corners. 

 

10.) Brush Tool 

This tool draws brush-like strokes as if you were painting. The brush lets you create 

special effects, including calligraphic effects and painting with the image in an imported 

bitmap. 

 

11.) Free Transform Tool 

You can use this tool to freely transform objects, groups, instances or            text blocks. 

You can perform individual transformation or combine several transformations such as 

moving, rotating, scaling, skewing, etc. 

 

12.) Fill Transform Tool 

 You can transform a gradient or bitmap fill by adjusting the size, direction  or center of            

the fill. 

 

13.) Ink Bottle Tool  

The Ink Bottle Tool is used to change the color, style, and thickness of Existing lines. It      

is often used in conjunction with the Dropper Tool. 

 

 

 

14.) Paint Bucket Tool 
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   This tool is used to fill enclosed areas with color, gradient or bitmap fills. It is used in 

conjunction with the Dropper Tool. 

 

      15.) Dropper Tool 

    This tool is used to copy the color and style information from existing  

     Pencil lines, strokes and fills. 

 

       16.) Eraser Tool 
     Erasing with the eraser tool removes lines and paint. You can quickly  

     Erase everything on Stage, erase line segments and fills, or erase by   

               Dragging. 

 

Symbols 
 

The Symbols come from objects that we've created using the tools that Flash 8 provides us.  

When transforming these objects into symbols, they are included in a library at the moment of 

creation that allows us using them on several occasions, either in the same or another movie.  

How to create a symbol  
 

Creating new symbol is one of the most used actions in Flash since it's one of the first steps to 

create an animation, how we'll see further. 

The procedure is the following: 

We select the object that we want to convert to a symbol. We open the dialog box of Symbol 

Properties, acceding to the menu Insert → New Symbol or just by pressing Ctrl + F8 or F8. 

 

Once done it will appear a window as the one of the image. We introduce the name of the 

symbol, which we are going to create. 

This is at the beginning and while we have few symbols it is not very important, but further it 

will be helpful for referring to the object. 

The only that remains is to select the type of symbol or behavior into which we convert our 

object. We can choose between Movie Clip, Button and Graphic. We'll discuss its characteristics 

and the differences among them in the next themes.  

BUTTON 
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The symbols of type Button contribute mostly in the interaction between Flash movies and the 

user. In Flash, a button is just as any button of any computer environment; Web or any other.  

They are elements that have to be pressed by the user for triggering a serie of actions. It's also 

usual to see how this type of elements responds when the mouse passes over them, or they are 

clicked, for example.  

Then, to obtain the mentioned interactive effects in other Web oriented languages we must create 

relatively large programs. This is a quite big disadvantage since the use of buttons is a very 

common practice in the Internet design. Nevertheless, in Flash it doesn't happen so. Its interface 

is designed in an special way for the buttons creation, which allows us to easily create all these 

effects.  

Like to the other symbols of Flash 8, the buttons have their own timeline. It is independent, but 

only four frames composes timeline, one for each possible state of the button.  

 

Up. The aspect of the button by default, in other words, when the mouse pointer is not placed 

over it nor pressing it.  

Over. Aspect of the button when we place the pointer over it.   

Down. Appearance that we want our button to have while we are pressing it.  

Active area (Hit). Here we must indicate the entire area in which we want our button to respond. 

This is very important in the composition of buttons, as we will see further on.  

It seems that the limitation of frames could imply a limitation in the great hit capacity and utility 

of these symbols, but it isn't so.  

The buttons can contain in its turn other symbols, like clips or graphics (also of Bitmap type). 

The sum of the possibilities of all the symbols equips the buttons with great hit.  

Creating a button   

  In the creation of a button we can consider two phases. First we are going to transform an 

object into a symbol of button type and then we will see how to complete it internally, which will 

help to us understand its structure better. 

First of all we’ll create the object that will represent the aspect of our button by designing it with 

the tools that Flash 8 offers us.  

We'll select the object and access to the menu Insert → Convert to Symbol, we'll set the  
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behavior Button and we’ll assign a name to our new symbol. 

 

In this way we've already transformed the object so that it behave like a button. Now we’ll 

complete it internally.  

To determine how the button must response to the mouse actions, we’ll edit it by right clicking 

our new button and selecting the option Edit. 

When we have the button timeline in front (notice that it has the aspect shown previously), we’ll 

select each one of the frames (over, up, down and hit) and click F6 to create a keyframe in each 

one of them.  

 

Now we can modify the initial aspect of the button for each position and set the area of the 

button action (Hit frame) in which we can just put down the same figure as the initial one (in 

this case only the object form is important, not the colors or other options) or draw with the 

Flash draw tools a new figure; our button "will be alluded" on this surface.  

 

This one is a basic button, as we’ll see it can become very complicated, but to start it’ll be useful.  

Once we've created the button, if we want to observe its different states without repeating 

everything, we can do it by accessing to the Library panel of our movie and dragging the button 

symbol. In order to see what we commented it’ll be enough to press the key located to the 

right of the preview of the symbol.  

Shapes in the Buttons   

  The buttons are symbols that can have large number of shapes. Although we usually see 

buttons of rectangular, square and circular shape, which creation is immediate as we saw in the 

previous point, there are also many other types of buttons, which we normally see on multitude 

of Web pages, in spite of its seldom use.  

 

 
Graphics 

The Graphics are symbols that allow us to represent static objects and simple animations.  

In the case we use a graphic symbol to make an animation, we should take into account that it 

will be bound to the timeline of the movie where it is. In other words, the animation will be 

played always if the original movie also is reproduced. This  causes that, in spite of having its 

own timeline, it can't contain sounds, controls nor other graphic symbols.  
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So, as a rule we use the graphics for static images or when it's convenient that an animation is 

played only if determined frame of the movie timeline is under way. 

Apart of the cases which we've previously commented, where a graphics is not handy, Flash 

provides us with another type of symbols as we'll see in next units.  

Types of Graphics  
 

The graphics can be: 

        a) Static: this graphic remains without changes. These graphics are typical on the background 

and on the objects that don't fulfill any special function. The size and consequently the load time of 

static graphics will be generaly reduced, although it will always depend on the resolution, on its 

dimensions and on the mode in which they are created. 

        b) Animated: this type of graphics varies its shape, position and others properties with time. 

Since to make the animation various graphics beyond the original one should be used or certain 

actions that can modify the initial state should be made, the size of animated graphics (for the same 

dimensions and form of creation) will be much more bigger than size of static one. 

       Because of this, although the animations provide our web more spectacular and attractive 

appearance, there are two inconveniences: 

               1) If it's about Bitmaps (now we'll see what it means) the web can arrive at an excessively 

large size in the end. 

               2) Although it isn't about bitmaps, for example, if there are typical Flash animations, 

which size isn't excessive, the setting of many animations can make the visitor a little bit "sick" of 

our site and therefore his attention from the really important issue: its content.  

(*) The previous types of graphics can be, in its turn, of two types, according to the way in which 

they are created: Vector or Bitmap Graphics. To understand better these two types of graphics, 

have a look at our basic theme.  

 

Tweened Animation: 

Tweened Animation is a huge timesaver and energy saver because it doesn’t require that you 

draw out your animation frame-by-frame. In tweened animation, you create starting and ending 

frames and flash create the frames in between. It is an effective way to create movement and 

changes over time while minimizing file size. Unlike frame-by-frame animation, Flash only 

needs to store the values for the changes between frames, not the entire frame.            Flash can 

create two types of tweened animation. 

1.) Motion Tweening 

Motion Tweening is useful for animating groups, symbols and editable text. It is used to 

move an element from one place to another, but it can do so much more than that. It 

enables you to scale, rotate, skew and move elements. 
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Steps to create a motion tween 

2.) Select the frame where you would like to start your animation by selecting Insert --> 

Keyframe or pressing F6. 

3.) Draw or import the image that you would like to tween. You can only motion tween 

symbols and editable text. 

4.) Select the frame that you would like to end your tween in. Turn this frame into a 

keyframe by pressing F6. 

5.) Position your image in the two endpoints. You cannot only move tweened elements, but 

you can also apply other effects such as scaling and rotation and change in color effects at 

this step. 

6.) Right click the initial frame and select Create Motion Tween. 

7.) Test your animation. 

2.) Shape Tweening 

Shape Tweening is useful for ‘morphing’ shapes between your endpoints. Flash can only 

Shape tween shapes. 

Steps to create a shape tween 

1.) Select the frame where you would like to start the animation. 

2.) Draw your starting image on the stage.  

3.) Add a second keyframe and draw your ending image on the stage. 

4.) Open the Frame properties dialog box by double clicking on any frame in between your 

two endpoint keyframes. 

5.) Select the Shape from the Tween drop-down menu. 

6.) Set different properties wherever required. Press the OK button. 

7.) Test the animation by pressing Control --> Play. 

Using Timeline effects: 

The Timeline organizes and controls a movie’s content over time in layers and frames. The most 

important components of the Timeline are frames, layers, and the play-head.            

 

 

Onion Skinning 

 
Frame-by-frame animation can be difficult when you're working on one frame at a time with no 

reference for the previous or next frames. In traditional animation, this problem is solved by the 

use of light desks or light tables, which let you see through multiple layers of paper as though 

they were transparencies, with the ink/pencil lines standing out clearly laid atop one another.  

Thankfully, Flash has an equivalent of this effect--known as onion-skinning, an option that you 

can turn on that shows a range of frames both before and after your current frame, progressively 

fading them out as if they're layered on translucent paper on top of each other, or "onion-

skinned". By dragging the edges of the greyed out block in your timeline you can expand or 
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reduce the number of frames displayed in onion-skin mode, to let you better follow and track 

your animation.  

The buttons for onion-skin mode can be found at the bottom of the timeline, to the far left before 

the division marking the layer control area. There are two buttons--one for onion skin, and to the 

right of that, one for onion skin outlines. Onion skin mode displays the solid images layered on 

top of each other (see the left-hand side of the image to the right of this page for an example), 

while onion skin outlines (on the right side of the image) only shows the outlines of the objects 

on each layer. Outline mode is recommended for long or detailed animations, as it's easier to 

render and scrub in realtime.  

Importing AND Exporting Graphics: 

Using imported artwork and video overview: Macromedia Flash MX can use artwork created 

in other applications. You can import vector graphics and bitmaps in a variety of file formats. If 

you have QuickTime 4 or later installed on your system, you can import additional vector or 

bitmap file formats. For more information, see Import file formats for vector or bitmap files. You 

can import FreeHand files (version 10 or earlier) and Fireworks PNG files directly into Flash, 

preserving attributes from those formats.  

When you import a bitmap, you can apply compression and anti-aliasing, place the bitmap 

directly in a Flash document, use the bitmap as a fill, edit the bitmap in an external editor, break 

the bitmap apart into pixels and edit it in Flash, or convert the bitmap to vector artwork. See 

Working with imported bitmaps.  

You can also import video into Flash. You can import files in Macromedia Flash Video format 

(FLV files) directly into Flash. For information on the FLV file format, see Exporting.  

If you have QuickTime 4 or later (Windows or Macintosh) or DirectX 7 or later (Windows only) 

installed on your system, you can import video in MOV, AVI, or MPEG format. Additional 

formats may be supported for import, depending on your system. Video clips can be imported as 

linked or embedded files. You can publish movies with imported video as SWF files or 

QuickTime movies. See Importing video.  

Flash compatible Video File Formats 

1) Macromedia flash video format (.flv) 

2) Flash Movie (.fla) 

3) Future Splash Movie (.spa) 

4) Smart Sketch Drawing (.ssk) 

5) Flash Player Movie (.swf) 

Publish setting 

Now that you have completed your Flash document, you are ready to publish it in a web page. 

The first step in this process is to save the FLA version of your document as a compressed SWF 

version of the file. This SWF version has a much smaller file size; because of this, it loads easily 

in a web browser. 

file:///C:\Program%20FilesMacromediaFlash%20MXHelpFlashhtml05_import3.html
file:///C:\Program%20FilesMacromediaFlash%20MXHelpFlashhtml05_import8.html
file:///C:\Program%20FilesMacromediaFlash%20MXHelpFlashhtml21_exporting.html
file:///C:\Program%20FilesMacromediaFlash%20MXHelpFlashhtml05_import15.html
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To publish your document as a SWF file: 

1. Select File > Publish Settings.  

2. In the Publish Settings dialog box, select the Formats tab and verify that only the HTML 

and Flash check boxes are selected.  

This causes Flash to publish only the SWF file and an HTML file to display it in a web 

browser. 

3. Still in the Publish Settings dialog box, select the Flash tab and verify that Flash Player 8 

is selected in the Version menu.  

This causes Flash to export the SWF file in Flash 8 format. 

4. Select the HTML tab and verify that Flash Only is selected from the Template menu.  

This causes Flash to generate only a simple HTML file to display the Flash document in a 

browser. 

5. Click Publish.  

Flash saves a SWF file copy of your document and an HTML file in the folder that 

contains your working FLA file. This should be the cafe_townsend directory. 

6. Click OK to close the Publish Settings dialog box.  

Now that you have completed the Flash FMA that will be used in the cafe_townsend website, 

you can go on to Tutorial: Building a Video Player (Flash Professional only).  

Guided and Masked Layer 

Normal Layers : This are the layers of Flash by default, and they have all the properties 

described in the previous points. They are used most commonly and for almost everything: to 

place objects, sounds, actions, and helps... 

Guide Layers : This are layers for special or specific content. They are used in the 

animations of objects movement and its only aim is to set the trajectory that this object must 

follow. Because its mission is to represent the trajectory of an animated object, its content 

usually is a line (straight, curve, etc).  

In this image we can see the content 

of 2 layers. The first of them 

contains the blue ball and the second 

contains the curved line. We have 

defined the second layer as Guide 

Layer, so that when making the 

movement animation (this we'll see 

it in a next unit) it will be used as a 
 

file:///C:\Documents%20and%20Settings\All%20Users\Application%20Data\Macromedia\Flash%208\en\Configuration\HelpPanel\Help\GettingStarted\00000092.html%23150002
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track for the blue ball. Its content 

wouldn't be seen in the movie. 

It is important to remember that the 

content of the Guide Layers will not 

be seen in the final movie. Its effect 

will cause that the blue ball moves 

from one end of the line to the other 

following that way. That's a 

beautiful effect, isn't it? 

Guided Layers : When we define a layer as a guide layer, it is necessary to define also a guided 

layer. This is, a layer that will be affected by the guide defined in the guide Layer.  

If we didn't define a guided layer, the guide layer will have not any effect and though it will not 

be seen in the movie (being a guide layer) it will not cause any effect in the other layers. In the 

previous image, the blue ball might have to be found in a Guided layer; otherwise it'll not follow 

the way set by the guide layer. 

The guide layers and the guided 

layers are related to each other in an 

evident way. A series of guided 

layers correspond to every guide 

layer.  

On associating a guide layer with a 

guided layer, a change on the guide 

layer icon will indicates that the job 

correctly done.  

In the image we can see an example 

of a guide layer and guided layers 

associated correctly. (Obviously, the 

Guided layer is the layer called 

aulaClic) 

 

The use of the Guide Layers and its utilities we'll see in detail in the unit of Motion Animations  

Mask Layers : These layers can be seen as groups that keep the unmasked layers off (we'll 

see them immediately). The use of these layers is something difficult (but not too much) and will 

be analyzed in following tutorials.  

It is enough to mention that these layers are placed "above" the layers, which they mask, and 

allow us to see only the part of the layer that cover up the objects located in the mask layer (they 

act like filters). Similar to the guide layers, the existing objects in this type of layers are not seen 

either in the final movie. Only the objects from their masked layer corresponding to the 

"covered" ones we'll be seen.  
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Masked Layers : These layers 

work jointly with the masked 

Layers. The mask layers and the 

masked layers must be associated to 

be involved correctly. 

Its objects are visible in the final 

movie, but only when some object of 

the Mask layer is on the top of them. 

  

 

Let's see the operation of these layers on an example. 

In this example, the blue rectangles are part of a Masked Layer and therefore they will be seen in 

the final movie (but only ones covered by the mask layer). The red oval is located in the Mask 

layer and it will not be seen in the movie, but only what "covers" it will be seen. Thus the masks 

are displayed in this way....  

 

 

                                                                                         

Alpha Effect    

Create an object, which color is transparent, in such a way as to see the objects that are 

behind  

Exercise step by step.     

1 Create a rectangle with the Rectangle Tool. 

2 The filling Color of the created rectangle will be the color 

selected at this moment in the Color Mixer Panel. For 

example, blue.  

3 Once it is created, we select the filling of the Rectangle 

and modify the value Alpha. For example, we set a value of 

45%. 

 
Blue Rectangle  

 
Now it is with 

Transparency 

If we place another image behind of our rectangle (in another layer), we can see how the effect 
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of the transparency over our filling reveals.  

 

 

Action Script 

Actions in the buttons 

 

Since the existence of multitude of actions that can be applied to the buttons, as well as to 

other elements of Flash 8 we are going to comment two of the most common ones:  

1) Opening a Web page. With this we’ll be able to open any Internet page (or a Flash movie), 

which will be used to browse through webs which contain more than one page, or to allow the 

user to download files among other things.  

For adding an action to a button is necessary the ActionScript use (in Unit 17 it will be treated 

deeper). 

So the steps to follow are: 

1. Select the button clicking on it. So it's the button where the action is associated to.  

2. Open the Action Panel clicking on its tab or through the menu Window → Actions.  

3. Click on the Script Assist button.  

4. On the left, select Global Functions → Browser/Network → getURL.  

5. When selecting the getURL command (which is the one that opens a link in a window 

browser), its respective options will be displayed on the right. Fill the URL field with the 

page you want to open and select in which window you want the link to be opened 

(_blank will open the link in a new window).  

6. Close the Action Panel and the button will be ready. You have added an action to your 

button.  

And this is the result:  

 

2) Controlling a movie under way. If we are reproducing a Flash movie and we want to allow 

the user to stop it, start it, play it, and play it back ....   

    For example, to stop a movie we must make our button on the stage of the movie, select it, and 

open the actions panel, then activate the Stop() function.  
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    After doing this, we would have to change, as we made in the previous animation, the 

moment at which the function must be executed, selecting the event on Press.  

We show above how the panel of the button actions would look like.    

Now whenever we press this button the movie will be stopped.  

In a similar way we would act doing so but with other control actions.  

 

Adding sound to a button    

  If our pages are going to have sound, the sound in the buttons is a fundamental part. For 

example, we can make the sounds to become activated when pressing a button. 

     For this, we must simply edit our button and select the frame Down. Now we must insert the 

sound. For example we could import one from our hard disk or take some that we already have 

in the library.  

The result could be something like this: 

   

 

 

 

Disclaimer: The study material is compiled by Premal Soni. The basic objective of this material 

is to supplement teaching and discussion in the classroom in the subject. Students are required to 

go for extra reading in the subject through Library books recommended by Sardar Patel 

University, Vallabh Vidyanagar. Students should also consult the subject teacher for the solution 

of their problems in order to enhance their subject knowledge. 

 

 


